PulseNet Standard Operating Procedure for PulseNet MLVA of *Salmonella enterica* Serotype Enteritidis – Applied Biosystems Genetic Analyzer 3130XL Platform

1. PURPOSE:
   To describe the standardized laboratory protocol for molecular subtyping of *Salmonella enterica* serotype Enteritidis.

2. SCOPE
   To provide PulseNet participants with a single protocol for performing MLVA of *S. enterica* serotype Enteritidis, thus ensuring inter-laboratory comparability of the generated results using the Applied Biosystems Genetic Analyzer 3130XL platform.

3. DEFINITIONS:
   3.1. **MLVA**: Multiple-locus variable-number tandem repeat analysis
   3.2. **VNTR**: Variable-number tandem repeat
   3.3. **DNA**: Deoxyribonucleic acid
   3.4. **DNase**: Deoxyribonuclease
   3.5. **PCR**: Polymerase chain reaction
   3.6. **HPLC**: High purity liquid chromatography
   3.7. **dNTP**: Deoxyribonucleotide triphosphate
   3.8. **CDC**: Centers for Disease Control and Prevention
   3.9. **SOP**: Standard Operating Procedure

4. RESPONSIBILITIES/PROCEDURE
   4.1. **Biosafety Warning**
      4.1.1. *S. enterica* serotype Enteritidis is a human pathogen causing serious disease. Always use a minimum of Biosafety level 2 practices and extreme caution when transferring and handling strains of this serotype. Work in a biological safety cabinet when handling large amounts of cells. Disinfect or dispose of all plastic ware and glassware that come in contact with the cultures in a safe manner.

   4.2. **Reagents, supplies, and equipment needed for DNA template preparation**
      4.2.1. Trypticase soy agar with 5 % sheep blood (TSA-SB) or comparable media
      4.2.2. 1 µl and 10 µl inoculation loops
      4.2.3. 0.5 ml microcentrifuge tubes
      4.2.4. DNase-free, molecular biology-grade water
      4.2.5. Vortex
      4.2.6. Boiling water bath or thermal block / thermocycler accommodating 0.5 ml tubes
      4.2.7. Tabletop centrifuge for high rpm (up to 13,000-14,000 rpm) spinning
4.3. Reagents, supplies, and equipment needed for PCR

4.3.1. DNA lysates from isolates (store at -20°C or -80°C freezer for long term)

4.3.2. PCR primers (see appendix PNL26-1)
   4.3.2.1. Fluorescent-labeled forward primers
       HPLC-purified
   4.3.2.2. Unlabeled reverse primers
       Regular gel filtration purification
   4.3.2.3. Biosearch Technologies (Novato, CA; www.biosearchtech.com; 1-800-436-6631) sells primers labeled with the three dyes needed for the protocol
   4.3.2.4. Divide the concentrated stocks in portions and store at -80°C freezer
       One vial should contain enough to prepare 25-50 µl of working solution.
       Avoid repetitive freeze-thaw cycles of concentrated primer stocks.
   4.3.2.5. The 2.5 µM, and 12.5 µM working solutions can be stored at either -20°C or -80°C freezer
   4.3.2.6. Prepare new working solutions every month or if a significant drop in the fluorescence level is observed (for instructions refer to PNQ06_MLVA ABI certification, appendix PNQ06-5)

4.3.3. 96-well polypropylene PCR plates (Fisher, Cat. No. 07-200-613) or Microamp PCR tubes without caps (Life Technologies, Cat. No. N8010533)

4.3.4. 8-well strip caps for polypropylene plate (Fisher, Cat. No. 07-200-639) or MicroAmp strip caps for individual tubes (Life Technologies, Cat. No. N8010535)

4.3.5. DNase-free, molecular biology-grade water

4.3.6. 1.5 ml Eppendorf microcentrifuge tubes

4.3.7. PCR Nucleotide mix (ready-to-use dNTP mix containing all four nucleotides; Roche, Cat. No. 11 814 362 001)

4.3.8. Platinum Taq Polymerase with 50 mM MgCl₂ and 10X buffer (Life Technologies Cat. No. 10966-034)

4.3.9. PCR cooling block (VWR International, Cat. No. 62111-762)

4.3.10. DNA Engine (Bio-Rad), GeneAmp (Life Technologies) or similar thermocycler with a heated lid option and 96-well block format

4.3.11. Parafilm M, 4” width (VWR, Cat. No. 52858-032)

4.3.12. Complete set (1000 µl, 200 µl, 100 µl, 20 µl, 10 µl, and 2 µl) of single channel pipettors for mastermix set-up (“clean set”)

4.3.13. A 1-10 µl single channel pipettor for adding DNA templates

4.3.14. Filtered tips for pipettors

4.3.15. Microfuge for low (up to 6,000 rpm) rpm spinning

4.4. Reagents, supplies and equipment needed for Genetic Analyzer 3130XL

4.4.1. DNase-free, molecular biology-grade water

4.4.2. PCR cooling block (VWR International, Cat. No. 62111-762)

4.4.3. 10 µl, 100 µl, and 1000 µl single channel pipettors

4.4.4. 1-10 µl and 20-200 µl multichannel pipettors

4.4.5. Filtered pipette tips

4.4.6. Sterile solution basins

4.4.7. 1.5 ml Eppendorf microcentrifuge tubes

4.4.8. 96-well polypropylene (non-PCR) V-bottom plate (for dilutions; Fisher Scientific, Cat. No. 07-200-698)

4.4.9. MicroAmp Optical 96-well reaction plates (Life Technologies, Cat. No. 4306737)

4.4.10. 96-well plate base (Life Technologies, Cat. No. 4317237)
4.4.11. Rubber septa for 96-well reaction plates (Life Technologies, Cat. No. 4315933)
4.4.12. 96-well plate retainer (Life Technologies, Cat. No. 4317241)
4.4.13. Hi-Di Formamide, 25 ml (Life Technologies, Cat. No. 4311320)
4.4.14. GeneFlo 625 DNA size standard – ROX, 800 µl (Chimerx, Cat. No. 3125-02)
4.4.15. Multi-Capillary DS-30 (Dye Set D) Matrix Standard Kit (Life Technologies, Cat. No. 4345827)
  4.4.15.1. Needed periodically to establish the system dye color spectra for the instrument. Required when analyzing fragments labeled with FAM, HEX, NED, and ROX.
  4.4.15.2. NOTE: DS-33 Matrix Standard (Dye set G5, required for analyzing fragments labeled with FAM, VIC, NED, PET, and LIZ) is typically installed as default as part of the instrument installation process.
  4.4.15.3. In order to install the DS-30 Matrix, follow the instructions of the kit insert and the “Getting Started Guide”, chapter “Performing a Spectral Calibration”
4.4.16. 3130XL & 3100 Capillary Array 50 cm (Life Technologies, Cat. No. 4315930)
4.4.17. Genetic Analyzer Buffer (10x) with EDTA, 25 ml (Life Technologies, Cat. No. 402824)
4.4.18. 3130XL POP7 Performance Optimized Polymer, 3.5 ml (Life Technologies, Cat. No. 4363785)
4.4.19. Parafilm M, 4” width (VWR, Cat. No. 52858-032)
4.4.20. 50 ml Conical tube
4.4.21. A rinse bottle containing distilled water
4.4.22. Centrifuge with a microtiter plate rotor
4.4.23. Heating block or thermal cycler accommodating a 96-plate for denaturation
4.4.24. Microfuge for low (up to 6,000 rpm) rpm spinning

4.5. Isolate preparation

4.5.1. DAY 0
  4.5.1.1. Streak an isolated colony from pure test cultures to TSA-SB plate (or comparable media). Incubate cultures at 37°C for 14-18 hrs.
4.5.2. DAY 1
  4.5.2.1. For each isolate to be typed, aliquot 100 µl of sterile, molecular biology-grade water into 0.5 ml microfuge tubes. Use a sterile, disposable 1 µl loop to pick 2-3 colonies (about half of a loop-full); rotate the loop in the microfuge tube to release the bacteria into the water. Cap and vortex for 10-15 seconds to disperse any clumps.
  4.5.2.2. Place the tubes in a 100°C water bath or heat block for 10 minutes. Cool briefly on ice or in fridge and centrifuge for 10 minutes at 10,000 rpm. Place on ice or in fridge while preparing PCR reactions. These DNA templates can be stored at -20°C or -80°C for several years.

4.6. PCR procedure

4.6.1. DAY 1
  4.6.1.1. Fill out, save with the run name, and print a PCR template worksheet (see appendix PNL26-2) with appropriately labeled samples (a maximum of 46 isolates/plate; 44 unknowns + two positive controls and a negative control; two wells are reserved for the internal ladder).
  4.6.1.1.1. For each isolate, two wells must be labeled as follows: BNkeyR1 where “BNkey” represents the isolate-specific state laboratory identification number (be sure to use the exactly same isolate ID that is used in the PFGE gels uploaded to the national database) and “R1” represents one of the two specific multiplex PCR reactions (R1, R2).
4.6.1.2. Fill out, and print a PCR mastermix calculation worksheet (see appendix PNL26-3) by typing the number of isolates to be tested (plus 2-3 extra) in the PCR mastermix calculators labeled R1 and R2. This number is highlighted in red and is next to “number of samples to be analyzed”. The mastermixes for reactions 1 and 2 (R1, R2) for one sample are as follows:

<table>
<thead>
<tr>
<th></th>
<th>Volume (µl)</th>
<th>Final conc</th>
</tr>
</thead>
<tbody>
<tr>
<td>PCR water</td>
<td>4.91</td>
<td></td>
</tr>
<tr>
<td>PCR buffer (10x)</td>
<td>1.00</td>
<td>1x</td>
</tr>
<tr>
<td>MgCl₂ (50 mM)</td>
<td>0.40</td>
<td>2.0 mM</td>
</tr>
<tr>
<td>dNTPs (10 mM)</td>
<td>0.20</td>
<td>0.20 mM</td>
</tr>
<tr>
<td>SE1-F (2.5 µM)</td>
<td>0.20</td>
<td>0.05 µM</td>
</tr>
<tr>
<td>SE1-R (2.5 µM)</td>
<td>0.20</td>
<td>0.05 µM</td>
</tr>
<tr>
<td>SE2-F (12.5 µM)</td>
<td>0.32</td>
<td>0.40 µM</td>
</tr>
<tr>
<td>SE2-R (12.5 µM)</td>
<td>0.32</td>
<td>0.40 µM</td>
</tr>
<tr>
<td>SE8-F (2.5 µM)</td>
<td>0.28</td>
<td>0.07 µM</td>
</tr>
<tr>
<td>SE8-R (2.5 µM)</td>
<td>0.28</td>
<td>0.07 µM</td>
</tr>
<tr>
<td>SE6-F (12.5 µM)</td>
<td>0.34</td>
<td>0.43 µM</td>
</tr>
<tr>
<td>SE6-R (12.5 µM)</td>
<td>0.34</td>
<td>0.43 µM</td>
</tr>
<tr>
<td>Taq (5 U/µl)</td>
<td>0.20</td>
<td>1.00 U</td>
</tr>
<tr>
<td>Total volume</td>
<td>9.00</td>
<td></td>
</tr>
<tr>
<td>$R^2$</td>
<td>Volume ($\mu{l}$)</td>
<td>Final conc</td>
</tr>
<tr>
<td>--------------</td>
<td>------------------</td>
<td>------------</td>
</tr>
<tr>
<td>PCR water</td>
<td>5.52</td>
<td></td>
</tr>
<tr>
<td>PCR buffer (10x)</td>
<td>1.00</td>
<td>1x</td>
</tr>
<tr>
<td>MgCl$_2$ (50 mM)</td>
<td>0.40</td>
<td>2.00 mM</td>
</tr>
<tr>
<td>dNTPs (10 mM)</td>
<td>0.20</td>
<td>0.20 mM</td>
</tr>
<tr>
<td>SE5-F (2.5 µM)</td>
<td>0.20</td>
<td>0.05 µM</td>
</tr>
<tr>
<td>SE5-R (2.5 µM)</td>
<td>0.20</td>
<td>0.05 µM</td>
</tr>
<tr>
<td>SE3-F (12.5 µM)</td>
<td>0.40</td>
<td>0.50 µM</td>
</tr>
<tr>
<td>SE3-R (12.5 µM)</td>
<td>0.40</td>
<td>0.50 µM</td>
</tr>
<tr>
<td>SE9-F (2.5 µM)</td>
<td>0.08</td>
<td>0.02 µM</td>
</tr>
<tr>
<td>SE9-R (2.5 µM)</td>
<td>0.08</td>
<td>0.02 µM</td>
</tr>
<tr>
<td>Taq (5 U/µl)</td>
<td>0.20</td>
<td>1.00 U</td>
</tr>
<tr>
<td>Total volume</td>
<td>9.00</td>
<td></td>
</tr>
</tbody>
</table>

4.6.1.2.1. **NOTE:** these primer concentrations serve as a starting point. Since laboratory-specific factors, such as the age of the primer stocks, calibration status of the thermocyclers and pipettes, etc. affect amplification efficiency, each laboratory will have to re-optimize the primer concentrations for optimal detection of all targets. However, any other parameters stated in the SOP should not be changed.

4.6.1.3. Thaw all reagents and supplies needed for PCR reactions and place on ice; keep primers light protected as much as possible.

4.6.1.3.1. **NOTE:** PCR mastermixes should be set up in a clean hood that is dedicated just for this purpose and where no cultures or DNA are handled.

4.6.1.4. Prepare the two separate PCR mastermixes in 1.5 ml Eppendorf tubes following the instructions in the PCR mastermix calculation worksheet (see appendix PNL26-3) and place on ice. Add the mastermix components in the following order: water, 10x PCR buffer, Mg$_2$Cl$_2$, dNTPs, primers, and then finally Taq polymerase. Mix the reaction mixture by vortexing briefly.

4.6.1.4.1. Vortex all reagents except Taq polymerase before adding to the mastermix. Taq may be briefly centrifuged with low rpm, if necessary, to pull the enzyme down to the bottom of the tube.

4.6.1.5. Place a 96-well PCR plate or required number of PCR tubes in a PCR cooling block.

4.6.1.6. Dispense 9.0 µl of each mastermix into the appropriate columns of the 96-well polypropylene plate / PCR tubes as noted in the PCR template worksheet (see appendix PNL26-2).

4.6.1.7. Add 1 µl of PCR water to each of the two different wells representing the negative controls of the two reactions.
4.6.1.8. Add 1.0 μl of DNA lysate to each of the two different wells representing the two PCR reactions. Use *S. enterica* serotype Enteritidis strain K1891 (ATCC25928) as a positive control (it is recommended to run the positive control in duplicate). The internal ladder to be used will be comprised of pooled PCR products of the isolates H9560 and 2010K0017 (see appendix PNL26-5 for instructions for ladder preparation).

4.6.1.9. Cover all wells / tubes with 8-well strip caps and firmly clamp down to avoid any evaporation during PCR amplification.

4.6.1.10. Recommendation: briefly spin down the plate / tubes to remove any air bubbles.

4.6.1.11. Setup the following PCR parameters and save the program as “SEMLVA”:

- **Step 1** 95°C for 5 minutes
- **Step 2** 94°C for 20 seconds
- **Step 3** 65°C for 20 seconds
- **Step 4** 72°C for 20 seconds
- **Step 5** Go to Step 2, 34x
- **Step 6** 72°C for 5 minutes
- **Step 7** Indefinite hold at 4°C

4.6.1.11.1. Make sure to use the heated lid option on the PCR block and “calculated” or tube control (instead of block or probe control) as a temperature control method.

4.6.1.12. When the PCR is complete, store the amplification products light-protected at 4°C until ready to run on the sequencer. If the fragment analysis is not performed the same day, the plate should be stored at -20°C or -80°C. The PCR products are stable for approximately one month, when stored frozen.

4.7. Initial setup of Genetic Analyzer 3130XL instrument

4.7.1. **NOTE:** Steps 4.7.3. and 4.7.4. only need to be performed before the very first run and every time a new working database is created.

4.7.2. Click on the “Run 3130XL Data Collection v 3.0” icon. The “Service Console” window will appear. If the connections are functioning properly, the “Messaging Service”, “Data Service”, “Instrument Service” and “Viewer” icons will change from red circles to green squares. The main window of the “Foundation Data Collection” software will open. Check to make sure system status is green.

4.7.3. Set up a results group:

4.7.3.1. On the left side of the window under “GA Instruments”, highlight “Results group” and click on “New”

4.7.3.2. The “Results Group Editor” window will appear

4.7.3.2.1. Under “General” tab, name the new results group as “SE results”

4.7.3.2.2. Under “Analysis” tab, select “GeneMapper-Generic” from the “Analysis type” drop-down menu. Leave “Analysis actions” unchecked

4.7.3.2.3. Under “Destination” tab, keep the default root destination (E:\AppliedBiosystems\udc\DataCollection\Data)

4.7.3.2.4. Under “Naming” Tab, select “Sample Name” from the first “Sample File Name Format” drop-down menu, and select “Plate Name” from the first “Run Folder Name Format” drop-down menu. Leave all other fields blank.

4.7.3.2.5. Under “Automated Processing” tab, leave the default “Only when the results group is complete” checked

4.7.4. Set up running conditions:

4.7.4.1. Under “GA Instruments”, click on + to expand “ga3130XL” subfolders
4.7.4.2. Highlight “Protocol Manager”. The instrument protocols will be listed on the right side of the window.

4.7.4.3. Click on “New”, and the “Protocol Editor” window will appear

4.7.4.3.1. Name the new protocol “FragTest”
4.7.4.3.2. Leave the protocol type as “Regular”
4.7.4.3.3. From the “Run Module” drop-down menu, select “Fragment Analysis 50_POP7_1” as running conditions.

4.7.4.3.3.1. NOTE: These are the instrument default running conditions for 50 cm capillary array and POP7 polymer. You can check the running conditions and modify them by highlighting “Module Manager” subfolder under ga3130XL and by double clicking on the protocol name. The default conditions are:

- Oven_Temperature: 60°C
- Poly Fill Vol: 7300 Steps
- Current Stability: 5.0 μAmps
- PreRun_Voltage: 15.0 kVolts
- Pre-Run-Time: 180 sec.
- Injection_Voltage: 1.6 kVolts
- Injection_Time: 15 sec.
- Voltage_Number_Of_Steps: 30 nk
- Voltage_Step_Interval: 15 sec.
- Data_Delay_Time: 200 sec.
- Run_Voltage: 15.0 kVolts
- Run time: 1800 sec.

4.7.4.3.4. From the “Dye Set” drop-down menu, select “D” as dye se

4.8. Genetic Analyzer 3130XL instrument preparation before each run

4.8.1. DAY 1

4.8.1.1. Make sure service console is open and all components are green. 

NOTE: Make sure a capillary array is installed in the instrument. For installation, follow the instructions of the “Install Capillary Wizard”. You can find the wizards by expanding the 3130XL subfolder by highlighting “Manual Control”. The “Wizards” drop-down menu will appear on top of the window.

4.8.1.2. Set up the plate run on the 3130XL manually, as detailed below, or follow the steps in the appendix PNL26-5 to create a template that can be used to import the plate set up from a separate Excel file

4.8.1.2.1. Under the ga3130XL, highlight “Plate Manager”
4.8.1.2.2. Click on “New” and a “New Plate Dialog Window” will appear
4.8.1.2.3. Name the run following the standardized PulseNet naming system: use the unique identifier code that was assigned to your laboratory by PulseNet for the first two to four letters of the file name. The next two spaces will indicate the year and the next four spaces will indicate the month and the date the run was performed. For example GA070426 is a run made at the GA Public Health Laboratory on April 26th 2007. If several runs are performed the same day, separate the file names by using sequential numbers, for example GA070426-1, GA070426-2.

4.8.1.2.4. From the “Application” drop-down menu, select “GeneMapper-Generic”
4.8.1.2.5. Type in the Owner Name and the Operator Name
4.8.1.2.6. Click "OK" and the "GeneMapper Plate Editor" window will appear

4.8.1.2.6.1. Type in the sample IDs

4.8.1.2.6.2. Select "SResults" from the "Results Group 1" drop-down menu for the first sample, highlight the results group column, and select “Fill Down” from the "Edit" drop-down menu

4.8.1.2.6.3. Select “FragTest” from the "Instrument Protocol 1" drop-down menu, highlight the instrument protocol column, and select “Fill Down” from the "Edit" drop-down menu

4.8.1.2.6.4. Click “OK”

4.8.1.3. Install the POP7 polymer in the instrument

4.8.1.3.1. Expand the 3130XL subfolder and highlight "Manual Control". The “Wizards” drop-down menu will appear on top of the window.

4.8.1.3.2. Follow the instructions of the "Replenish Polymer Wizard"

4.8.1.3.2.1. **NOTE:** if an old polymer (been on the instrument > 7 days) is switched to a new one follow the instructions of the “Water Wash Wizard” until you reach the step in which the array port should be flushed. At this point, if you don’t see an air bubble in the port, cancel out the water wash wizard and perform a spatial calibration with a capillary fill. If you see an air bubble in the port perform the flush as instructed by the wizard and then continue to capillary fill as instructed.

4.8.1.3.2.2. **NOTE:** Use distilled water that has been heated to 37-40°C for water wash.

4.8.1.3.2.3. **NOTE:** water wash should be performed once a week

4.9. Fragment analysis sample preparation

4.9.1. Day 1

4.9.1.1. Thaw the Hi-Di Formamide, the GeneFlo 625 DNA size standard and the internal ladder (see appendix PNL26-4) and place on ice.

4.9.1.1.1. **NOTE:** aliquot Hi-Di Formamide (500 µl / tube) and the size standard (50 µl / tube) in order to avoid frequent freeze-thaw cycles.

4.9.1.2. Prepare a 96-well V-bottom plate for diluting the PCR reactions. Using a 200 µl multichannel pipettor and a solution basin, dispense 19 µl of molecular-grade water in the required number of wells.

4.9.1.3. Remove the plate / tubes with the PCR reactions from the thermocycler. Briefly spin down the plate / tubes, if necessary. Use a 10 µl multichannel pipettor to transfer 1 µl of each PCR reaction directly across to the corresponding set of wells in the dilution plate. In order to avoid cross-contamination, remove the strip cap from just one column at a time and recap the column before opening the next one.

4.9.1.4. Add 3 µl of internal ladder in two wells.

4.9.1.5. Using a 200 µl multichannel pipettor, mix the dilutions by pipetting up and down a few times. Cover the plate with parafilm and put in the fridge or on ice.

4.9.1.6. Prepare a fragment analysis master mix containing DNA size standard and Hi-Di Formamide for the samples following the calculations indicated in the table below. The fragment analysis master mix calculations can also be performed using the autocalculate box at the bottom of the PCR template worksheet (see appendix PNL26-2. Vortex briefly and place on ice.
**Reagents** | **Fragment analysis mastermix**
---|---
Hi-Di Formamide | 8 µl x (#samples +3)=
GeneFlo 625 bp size standard | 1 µl x (# samples +3)=

4.9.1.7. Place a MicroAmp Optical 96-well sample plate in a cold block. Aliquot 9 µl of the prepared fragment analysis mastermix to the required number of wells. Cover the plate loosely with Parafilm.

4.9.1.8. Using the 10 µl multichannel pipettor, add 1 µl of 1:20 diluted PCR reactions to the appropriate columns in the sample plate. Keep sliding the Parafilm sheet from column to column to keep track of the sample order.

4.9.1.9. Denaturate templates by heating the reaction plate uncovered in a thermocycler at 95°C for 3 min.

4.9.1.10. Manually turn on the oven of the 3130XL, by using the Command options under the Manual Control submenu to change the set point to 60°C.

4.9.1.11. While the templates denaturate, prepare 30 ml 1X running buffer:
   4.9.1.11.1. Add 3 ml of 10X Genetic Analyzer buffer in a 50 ml conical tube
   4.9.1.11.2. Add purified water to bring the total volume up to 30 ml
   4.9.1.11.3. Mix well by inverting

4.9.1.12. Briefly spin down the sample plate to remove any air bubbles

4.9.1.13. Place the sample plate in a plate base. Seal the plate with the rubber septa. Snap the plate retainer onto the plate and the plate base.

4.9.1.14. Place the plate assembly and the buffer into the Genetic Analyzer 3130XL.
   4.9.1.14.1. Push on the tray button at the front of the Genetic Analyzer 3130XL to bring the autosampler to the forward position. Open the instrument doors.
   4.9.1.14.2. Place the plate assembly on the autosampler in position A or B with the notched end of the plate base away from you
   4.9.1.14.3. Add 1X running buffer to the anode and cathode reservoirs
   4.9.1.14.4. Add distilled water to the waste and rinse reservoirs
   4.9.1.14.5. Close the instrument doors and wait for the green light to illuminate

4.9.1.15. Start the run after making sure the system status is green.
   4.9.1.15.1. Expand 3130XL computer name icon.
   4.9.1.15.2. Highlight “Run Scheduler”
   4.9.1.15.3. Click on “Find All”
   4.9.1.15.4. Highlight the plate name for the run
   4.9.1.15.5. Link the plate by clicking on the yellow squares on the right side of the window
   4.9.1.15.6. The “Start Run” button will turn green indicating that the run can be started. Click on this button, and then click “OK” on the alert window. The run will start.

**4.10. Data export from the Genetic Analyzer 3130XL**

4.10.1. **DAY 2**

4.10.1.1. **NOTE:** Steps 4.10.1.3 and 4.10.1.4 only need to be performed before the very first analysis.

4.10.1.2. Double-click on the shortcut icon for GeneMapper v.4.0 and enter the appropriate password to access the software. The main menu window will open.

4.10.1.3. **Set up the size standard:**
4.10.1.3.1. From the “Tools” drop-down menu, select “GeneMapper Manager”. A “GeneMapper Manager” window will open.

4.10.1.3.2. Select the “Size Standards” tab

4.10.1.3.3. Click on “New”, leave the default option “Basic or Advanced” checked and click “OK”. “Size Standard Editor” window will appear.

4.10.1.3.4. Name the new size standard “GeneFlo 625”

4.10.1.3.5. Leave the default option “Red” as “Size Standard Dye”

4.10.1.3.6. Enter sizes for each peak in the table (refer to the GeneFlo 625 product insert for the peak sizes)

4.10.1.3.7. When finished, click “OK”.

4.10.1.3.7.1. Click on “Apply”.

4.10.1.4. **Set up analysis method:**

4.10.1.4.1. From the “Tools” drop-down menu, select “GeneMapper Manager”. A “GeneMapper Manager” window will open.

4.10.1.4.2. Select the “Analysis Methods” tab

4.10.1.4.3. Click on “New”, leave the default option “Microsatellite” checked and click “OK”. “Analysis Methods Editor” window will appear.

4.10.1.4.4. Name the new method “SEMLVA” and click “OK”

4.10.1.4.5. Highlight the new method name “SEMLVA” and click “Open”

4.10.1.4.6. Select the “Peak Detector” tab and change “Peak Detection Algorithm” to “Advanced” from the drop-down menu

4.10.1.4.7. Input the following analysis settings and click “OK” when finished:

- Analysis: Full Range
- Sizing: Partial Sizing
  - Start Size: 50
  - Stop Size: 625
- Smoothing: none
- Baseline window: 51 pts
- Size Calling Method: Local Southern Method
- Peak Amplitude Thresholds
  - B: 500
  - G: 500
  - Y: 250
  - R: 20
  - O: 50
- Min. Peak Half Width: 2 pts
- Polynomial Degree: 2
- Peak Window Size: 21 pts
- Slope Threshold
  - Peak Start: 0.0
  - Peak End: 0.0

4.10.1.5. From the “File” drop-down menu select “Add Samples to Project”

4.10.1.6. Find the folder containing the data file to be analyzed: My Computer → E → Applied Biosystems → UDC → Data Collection → Data

4.10.1.7. Highlight the desired file(s) and click on “Add to List”. File(s) will appear in the window on the right. Click “Add” below the file list to return to the original screen.
4.10.1.8. Samples in the selected file(s) will be listed in a new window and the “Analyze” (play) button appears in green color in the toolbar indicating that the files are ready to be analyzed

4.10.1.9. Select the size standard GeneFlo 625 for the first sample, highlight the size standard column, and select “Fill Down” from the “Edit” drop-down menu

4.10.1.10. Select the analysis method SEMLVA for the first sample, highlight the analysis method column, and select “Fill Down” from the “Edit” drop-down menu

4.10.1.11. Highlight all samples to be analyzed and click the “Play” icon

4.10.1.12. Name the project with the run name (for example, “GA070426”) and click “OK”

4.10.1.13. A successful analysis is indicated by green squares. Yellow triangles indicate problematic components (i.e. missing size standard peaks). Red circles indicate that results fell below acceptable quality values. Samples with yellow or red circles in the SQ column should be selected for re-analysis.

4.10.1.13.1. To resolve failed analyses due to sub-optimal molecular marker peak profile (i.e. miscalling of peaks), select a row with a yellow triangle or red circle in the SQ column and click on the “Size Match Editor” icon on the toolbar. “Size Match Editor” view will appear.

4.10.1.13.2. Place the cursor near the X-axis to activate the magnifying lens, and then pull up (mouse left-click and hold) to zoom in a specific area to facilitate editing

4.10.1.13.3. Left-click at the base of a peak to select. Right-click and select “Add”, “Delete”, or “Change”.

4.10.1.13.4. Select the correct molecular weight for the selected peak from the drop-down menu. Repeat this process for all other miscalled peaks. Click “OK” when finished.

4.10.1.13.5. After the size standard has been adjusted, click the “Play” button to re-analyze the data. After a successful analysis, the samples will have green squares under the SQ column. If the size standard cannot be adjusted, the reaction is considered a fragment analysis failure and must be re-run

4.10.1.14. Check the fragment result data (the fluorescent peaks) for each well by highlighting the well ID and by clicking on the “Display Plots” icon on the toolbar.

4.10.1.14.1. Make sure that all seven VNTRs amplified in the K1891 control and that the fragment sizes are within the range specified in the appendix PNL26-2 and record the fragment sizes on the PCR template worksheet.

4.10.1.14.2. The size calling for the internal ladder should also be within the range specified in the appendix PNL26-2 (or PNL26-4).


4.10.1.15. Export the peak file:

4.10.1.15.1. **NOTE: the following columns should appear in the exported table in the following order from left to right:** “Dye/Sample”, “Sample file name”, “Marker”, “Size”, “Height”, “Area”, “Data point”. The format of the table can be modified by selecting “Table setting editor” from the “Tools” drop down menu. Select the “Genotype” tab and make sure that the boxes for the above mentioned columns are checked and no additional boxes are checked.

4.10.1.15.2. Highlight the samples for which you want to export peak data

4.10.1.15.3. Click on “Display Plots” icon on the toolbar

4.10.1.15.4. Click on “Sizing Table” icon on the toolbar and a table will appear below the electropherograms
4.10.1.15.5. From the “File” drop-down menu, select "Export Table"
4.10.1.15.6. Select the location (for example a flash drive) where you want to export the data
4.10.1.15.7. Name the export file with the run name (for example GA070426) and make sure the file type is tab-delimited text (.txt) file
4.10.1.16. The remaining gel can stay in the instrument if it is going to be used within seven days

5. Bibliography

6. Contacts: PulseNet Next Generation Subtyping Unit, EDLB, DFWED, CDC
   6.1. Eija Trees, D.V.M., Ph.D (404) 639-3672 EHyytia-Trees@cdc.gov
   6.2. Patti Lafon (404) 639-2828 PLafon@cdc.gov
   6.3. Ashley Sabol (404) 639-2947 ASabol@cdc.gov
### Appendix PNL26-1

**S. enterica** serotype Enteritidis MLVA PCR Primers

<table>
<thead>
<tr>
<th>R1 Locus</th>
<th>Dye</th>
<th>Forward Primer (5’ to 3’)</th>
<th>Reverse Primer (5’ to 3’)</th>
</tr>
</thead>
<tbody>
<tr>
<td>SE-1</td>
<td>FAM</td>
<td>TGT GGG ACT GCT TCA ACC TTT GGG C</td>
<td>CCA GCC ATC CAT ACC AAG ACC AAC ACT CTA TGA</td>
</tr>
<tr>
<td>SE-2</td>
<td>CallRed590</td>
<td>GTG CTT CCT CAG GTT GCT TTT AGC CTT GTT CG</td>
<td>GGG GAA TGG ACG GAG GCG ATA GAC G</td>
</tr>
<tr>
<td>SE-8</td>
<td>HEX</td>
<td>GGT AGC TTG CCG CAT AGC AGC AGA AGT</td>
<td>GGC GGC AAG CGA GCG AAT CC</td>
</tr>
<tr>
<td>SE-6</td>
<td>FAM</td>
<td>CTG GTC GCA GGT GTG GC</td>
<td>GGT GAC GCC GTT GCT GAA GGT AAT AAC AGA GTC</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>R2 Locus</th>
<th>Dye</th>
<th>Forward Primer (5’ to 3’)</th>
<th>Reverse Primer (5’ to 3’)</th>
</tr>
</thead>
<tbody>
<tr>
<td>SE-5</td>
<td>HEX</td>
<td>GGC TGG CGG GAA ACC ACC ATC</td>
<td>GCC GAA CAG CAG GAT CTG TCC ATT AGT CAC TG</td>
</tr>
<tr>
<td>SE-3</td>
<td>CallRed590</td>
<td>CGG GAT AAG TGC CAC ATA ACA CAG TCG CTA AGC</td>
<td>CGC CAG TGT TAA AGG AAT GAA TGA ACC TGC TGA TG</td>
</tr>
<tr>
<td>SE-9</td>
<td>FAM</td>
<td>CCA CCT CTT TAC GGA TAC TGT CCA CCA GC</td>
<td>GGC GTT ACT GGC GGC GTT CG</td>
</tr>
</tbody>
</table>

*Primer sets are listed as multiplex PCR cocktails.*
### Appendix PNL26-2

**S. enterica serotype Enteritidis MLVA PCR template Worksheet for ABI**

<table>
<thead>
<tr>
<th>A</th>
<th>B</th>
<th>C</th>
<th>D</th>
<th>E</th>
<th>F</th>
<th>G</th>
<th>H</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>2</td>
<td>3</td>
<td>4</td>
<td>5</td>
<td>6</td>
<td>7</td>
<td>8</td>
</tr>
<tr>
<td>9</td>
<td>10</td>
<td>11</td>
<td>12</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>1</th>
<th>2</th>
<th>3</th>
<th>4</th>
<th>5</th>
<th>6</th>
<th>7</th>
<th>8</th>
<th>9</th>
<th>10</th>
<th>11</th>
<th>12</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>M6</th>
<th>32</th>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>600 hp</td>
<td>4.00</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

1. For each isolate, fill in an appropriate BioNumerics key number for PCR reactions R1 and R2 (for example: for an isolate K1720 the ISN key numbers are K1720R1 and K1720R2).

2. Fill in the exact number of fragment analysis reactions (2 per isolate + controls) in the red box (extra already included in calculation).

3. Mix the Hi-Di Formamide and 625 bp ladder in an appropriate tube. Add 9 µl of mixture to each well.

4. Using a multichannel pipettor, add 1 µl of diluted PCR reaction to wells containing 9 µl of Formamide/625 bp ladder mixture.

5. Denature the plate at 95°C for 3 min

6. Briefly spin down the plate

7. Place the plate in the plate base; cover the wells with a rubber septa; finish the plate assembly by snapping on the plate retainer.

<table>
<thead>
<tr>
<th><strong>Salmonella Enteritidis</strong></th>
<th><strong>Positive Control (K1891)</strong></th>
</tr>
</thead>
<tbody>
<tr>
<td>R1 Fragment sizes</td>
<td>R2 Fragment sizes</td>
</tr>
<tr>
<td>SFL (100 - 150)</td>
<td>SF9 (181 - 180)</td>
</tr>
<tr>
<td>SF2 (153 - 316)</td>
<td>SF3 (201 - 203)</td>
</tr>
<tr>
<td>SF8 (433 - 436)</td>
<td>SF5 (211 - 214)</td>
</tr>
<tr>
<td>SF1 (479 - 492)</td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th><strong>Salmonella Enteritidis - Internal Ladder fragment sizes</strong></th>
</tr>
</thead>
<tbody>
<tr>
<td>Expected Size Ranges</td>
</tr>
<tr>
<td>SF9 181 - 181</td>
</tr>
<tr>
<td>SF1 153 - 221</td>
</tr>
<tr>
<td>SF3 199 - 203</td>
</tr>
<tr>
<td>SF5 201 - 203</td>
</tr>
<tr>
<td>SF2 317.5 - 324</td>
</tr>
<tr>
<td>SF8 346 - 350</td>
</tr>
<tr>
<td>SF6 446 - 447</td>
</tr>
</tbody>
</table>
**Appendix PNL26-3**

**PCR Mastermix Calculations**

*NOTE: This is posted on SharePoint as an Excel file so users may save it locally, enter data, and use the auto calculate function.*

### PCR Mastermix calculations

*Type in the number of reactions (~2 extra), currently a red zero, next to “Number to analyze” for autocalculations.*

<table>
<thead>
<tr>
<th>PCR run by:</th>
<th>Date:</th>
<th>Thermal cycle:</th>
</tr>
</thead>
<tbody>
<tr>
<td>DD</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

#### A. Total Reaction Volume

<table>
<thead>
<tr>
<th></th>
<th>Row 1</th>
<th>Row 2</th>
<th>Row 3</th>
<th>Row 4</th>
<th>Row 5</th>
<th>Row 6</th>
</tr>
</thead>
<tbody>
<tr>
<td>PCR Buffer</td>
<td>1X</td>
<td>1X</td>
<td>1X</td>
<td>1X</td>
<td>1X</td>
<td>1X</td>
</tr>
<tr>
<td>MgCl2</td>
<td>3.5mM</td>
<td>3.5mM</td>
<td>3.5mM</td>
<td>3.5mM</td>
<td>3.5mM</td>
<td>3.5mM</td>
</tr>
<tr>
<td>dNTPs</td>
<td>8.0mM</td>
<td>8.0mM</td>
<td>8.0mM</td>
<td>8.0mM</td>
<td>8.0mM</td>
<td>8.0mM</td>
</tr>
<tr>
<td>BSA</td>
<td>0.25μg</td>
<td>0.25μg</td>
<td>0.25μg</td>
<td>0.25μg</td>
<td>0.25μg</td>
<td>0.25μg</td>
</tr>
<tr>
<td>BSA</td>
<td>0.25μg</td>
<td>0.25μg</td>
<td>0.25μg</td>
<td>0.25μg</td>
<td>0.25μg</td>
<td>0.25μg</td>
</tr>
<tr>
<td>BSA</td>
<td>0.25μg</td>
<td>0.25μg</td>
<td>0.25μg</td>
<td>0.25μg</td>
<td>0.25μg</td>
<td>0.25μg</td>
</tr>
<tr>
<td>Platinum Taq</td>
<td>1 μl</td>
<td>1 μl</td>
<td>1 μl</td>
<td>1 μl</td>
<td>1 μl</td>
<td>1 μl</td>
</tr>
<tr>
<td>PCR Water</td>
<td>4.9 μl</td>
<td>4.9 μl</td>
<td>4.9 μl</td>
<td>4.9 μl</td>
<td>4.9 μl</td>
<td>4.9 μl</td>
</tr>
</tbody>
</table>

#### B. Potential multiplex PCR

<table>
<thead>
<tr>
<th></th>
<th>Row 1</th>
<th>Row 2</th>
<th>Row 3</th>
<th>Row 4</th>
<th>Row 5</th>
<th>Row 6</th>
</tr>
</thead>
<tbody>
<tr>
<td>PCR Buffer</td>
<td>1X</td>
<td>1X</td>
<td>1X</td>
<td>1X</td>
<td>1X</td>
<td>1X</td>
</tr>
<tr>
<td>MgCl2</td>
<td>3.5mM</td>
<td>3.5mM</td>
<td>3.5mM</td>
<td>3.5mM</td>
<td>3.5mM</td>
<td>3.5mM</td>
</tr>
<tr>
<td>dNTPs</td>
<td>8.0mM</td>
<td>8.0mM</td>
<td>8.0mM</td>
<td>8.0mM</td>
<td>8.0mM</td>
<td>8.0mM</td>
</tr>
<tr>
<td>BSA</td>
<td>0.25μg</td>
<td>0.25μg</td>
<td>0.25μg</td>
<td>0.25μg</td>
<td>0.25μg</td>
<td>0.25μg</td>
</tr>
<tr>
<td>BSA</td>
<td>0.25μg</td>
<td>0.25μg</td>
<td>0.25μg</td>
<td>0.25μg</td>
<td>0.25μg</td>
<td>0.25μg</td>
</tr>
<tr>
<td>BSA</td>
<td>0.25μg</td>
<td>0.25μg</td>
<td>0.25μg</td>
<td>0.25μg</td>
<td>0.25μg</td>
<td>0.25μg</td>
</tr>
<tr>
<td>Platinum Taq</td>
<td>1 μl</td>
<td>1 μl</td>
<td>1 μl</td>
<td>1 μl</td>
<td>1 μl</td>
<td>1 μl</td>
</tr>
<tr>
<td>PCR Water</td>
<td>4.9 μl</td>
<td>4.9 μl</td>
<td>4.9 μl</td>
<td>4.9 μl</td>
<td>4.9 μl</td>
<td>4.9 μl</td>
</tr>
</tbody>
</table>

#### PCR Reagents

<table>
<thead>
<tr>
<th></th>
<th>Exp.</th>
<th>Lot#</th>
</tr>
</thead>
<tbody>
<tr>
<td>10X Buffer</td>
<td></td>
<td></td>
</tr>
<tr>
<td>MgCl2</td>
<td></td>
<td></td>
</tr>
<tr>
<td>dNTPs</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Platinum Taq</td>
<td></td>
<td></td>
</tr>
<tr>
<td>ddPCRdPCR</td>
<td></td>
<td></td>
</tr>
<tr>
<td>ddPCRddPCR</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
Instructions to prepare the internal ladder

1. Prepare DNA templates from isolates H9560 and 2010K0017 as described in the protocol step 4.5. Store the templates at -20°C or -80°C freezer.
2. Use the DNA templates to set up and run the PCR reactions R1 and R2 as described in the protocol step 4.6.
3. After the PCR amplification, pool the R1 and R2 reactions for isolates H9560 and 2010K0017 into one single PCR tube to gain a total volume of 40 µl.
4. Each new lot of internal ladder must be tested against the old ladder lot by running them in the same fragment analysis run.
5. Store the ladder in -20°C or -80°C freezer. It should remain stable at least 5-6 freeze-thaw cycles for a period of one month.

Expected fragment sizes (bp) of the thirteen fragments present in the internal ladder from smallest to the largest in the order they appear in the electropherogram:

<table>
<thead>
<tr>
<th>Fragment</th>
<th>Sizes</th>
</tr>
</thead>
<tbody>
<tr>
<td>SE9 (B)</td>
<td>181-184</td>
</tr>
<tr>
<td>SE1 (B)</td>
<td>190-193</td>
</tr>
<tr>
<td></td>
<td>211-212</td>
</tr>
<tr>
<td>SE3 (B)</td>
<td>199-203</td>
</tr>
<tr>
<td></td>
<td>211-214</td>
</tr>
<tr>
<td>SE5 (G)</td>
<td>201-203</td>
</tr>
<tr>
<td></td>
<td>218-221</td>
</tr>
<tr>
<td>SE2 (G)</td>
<td>317.5-324</td>
</tr>
<tr>
<td></td>
<td>363-364</td>
</tr>
<tr>
<td>SE8 (Y)</td>
<td>346-350</td>
</tr>
<tr>
<td></td>
<td>433-436</td>
</tr>
<tr>
<td>SE6 (Y)</td>
<td>446-447</td>
</tr>
<tr>
<td></td>
<td>479-482</td>
</tr>
</tbody>
</table>

Expected fragment sizes (bp) of the thirteen fragments present in the internal ladder by the dye in the order they appear in the peak file:

<table>
<thead>
<tr>
<th>Fragment</th>
<th>Sizes</th>
</tr>
</thead>
<tbody>
<tr>
<td>SE3 (B)</td>
<td>199-203</td>
</tr>
<tr>
<td></td>
<td>211-214</td>
</tr>
<tr>
<td>SE2 (G)</td>
<td>317.5-324</td>
</tr>
<tr>
<td></td>
<td>363-364</td>
</tr>
<tr>
<td>SE5 (G)</td>
<td>201-203</td>
</tr>
<tr>
<td></td>
<td>218-221</td>
</tr>
<tr>
<td>SE8 (Y)</td>
<td>346-350</td>
</tr>
<tr>
<td></td>
<td>433-436</td>
</tr>
<tr>
<td>SE9 (B)</td>
<td>181-184</td>
</tr>
<tr>
<td>SE1 (B)</td>
<td>190-193</td>
</tr>
<tr>
<td></td>
<td>211-212</td>
</tr>
<tr>
<td>SE6 (Y)</td>
<td>446-447</td>
</tr>
<tr>
<td></td>
<td>479-482</td>
</tr>
</tbody>
</table>

*NOTE: fragment sizes for the internal ladder based on independent runs on multiple instruments at CDC and in PulseNet Participating Laboratories*
Appendix PNL26-5
Steps for exporting and importing plate set ups on the ABI 3130XL

**Note:** the procedure described below will require the sequencer computer to have Microsoft Office. If the sequencer computer does not have Microsoft Office, the exported file needs to be saved on a flash drive so that steps 8 through 15 can be performed on a computer with Microsoft Office.

1. Under “GA Instruments”, click on the + to expand the “ga3130xl” subfolders on the left-hand menu
2. Highlight “Plate Manager” and on the right side of the window click “Find All” to list all of the available plates
3. Find the most recent full plate. Click on the ID to highlight the desired plate and then click the “Export…” button at the bottom of the screen
   3.1. **NOTE:** If you do not have a full plate, create a new one by filling in each sample ID space (A01 through H12) with “test” and saving it with the plate name “SE_Template”. Be sure to add the results group “SEresults” and instrument protocol “FragTest” for each sample. It is necessary to have all required wells filled in when exporting so that they will be available in your exported file
4. In the export window, create a new folder on the desktop by clicking the “Desktop” icon on the left side of the window. Find the ‘create new folder’ button on the top right side of the window and name the new folder “MLVA Plate Setup”
5. Save the file to this folder by using your new plate name (e.g. - CDC101020) and clicking “Save”
6. A window will pop up letting you know that the plate has been successfully exported. Click “OK”
7. Minimize the 3130xl Viewer and open the “MLVA Plate Setup” folder on the desktop
8. Right-click your plate name, select “Open With” and in the submenu select Microsoft Office Excel.
9. Sample IDs can be typed or copied and pasted from a separate Excel file into the spaces next to the correct wells under the “Sample Name” heading. The first sample ID must be directly under the “Sample Name” heading
   9.1. **NOTE:** Do not change/delete any of the column headings. The fields must be in the same format when importing as they were when exported. Additionally, the software will not import IDs with special characters (e.g. - !, /, ) , etc) or spaces. You can use underscores and dashes
10. The “Container Name” should be changed to match the plate/file name, and initials should be placed under the ‘owner’ and ‘operator’ headings
   10.1. **NOTE:** If the container name is not changed it cannot be imported because it will be recognized as a plate that is already in the system
11. Once all of the IDs are inserted, make sure that for each sample ID and all controls the priority is “100”, the results group name “SEresults” is under the “Results Group 1” heading, and the running method “FragTest” is under the “Instrument Protocol 1” heading
12. For all unused wells, everything under the headings “Well”, “Priority”, “Results Group 1”, and “Instrument Protocol 1” must be deleted. This can be done by clicking the first cell to be deleted under these columns and dragging until the entire section is highlighted. Right-click in the highlighted area and from the drop-down menu select “Clear Contents”
13. Under the “File” drop-down menu select “Save”
14. A warning window will appear asking if the workbook should be saved in the “Text (tab-delimited)” format. Click “Yes”
15. Exit Microsoft Excel, clicking “No” when prompted to save changes
16. Go back to the ABI 3130 plate manager window and click the “Import…” button at the bottom of the screen
17. In the import window, navigate to the recently created plate under Desktop/MLVA Plate Setup, select the appropriate .txt file and click “Open”
18. When the file has been imported, a “Progress” window will appear stating that the plate was “successfully imported”. Click “OK”

18.1. *NOTE:* For repeated use, plate templates can be created by exporting a plate to the “MLVA Plate Setup” folder. Save the file as a tab-delimited text file with ‘test’ as the sample ID and with a new plate name (e.g. “SE_Template”). After you have filled out the information for a new run on the template, save it in step 13 with the standardized run name (e.g. - CDC101020). Since the results group is different for each assay (STECO157, Salmonella Typhimurium, Salmonella Enteritidis, etc), separate templates with results groups assigned, must be exported and saved accordingly.